
Laborator 3 

Exemplu de proiectare de circuite pasive în structuri integrate 

utilizând exemple de circuite 

 

Tema de proiectare 

Să se realizeze un filtru trece bandă, în tehnologie microstrip, utilizând o structură cu 

rezultate cunoscute, prezentată în literatură. 

 

Relaţii utilizate 

 Se alege utilizarea unei structuri tipice de filtru interdigital. Un astfel de circuit este 

prezent între fişierele Sonnet, în secţiunea exemple, proiectul "filtwall.son". Acest filtru este 

realizat pe un substrat din alumină (Al2O3 - εr = 9.8, tan δ = 10
-4

) cu grosimea de 15 mil. Se 

folosesc 5 secţiuni de linie de transmisie (dimensiuni 22/24/26mil×214mil) spaţiate cu 

30/32/38mil (pentru detalii deschideţi fişierul exemplu).  

 Caracteristicile acestui filtru sunt prezentate în figura următoare, banda obţinută fiind 

între 4.95GHz - 5.3GHz cu atenuare înafara benzii foarte bună (atenuare > 30dB la 4.75GHz 

şi 5.35GHz). Aceleaşi performanţe vor fi dificil de realizat pe un substrat de circuit integrat 

(se reaminteşte că alumina este un dielectric foarte bun utilizat în circuitele integrate în timp 

ce substratul în circuitele integrate monolitice este un material semiconductor) 

 
 

 Trecerea la structura de circuit integrat aduce câteva deosebiri esenţiale care modifică 

total comportamentul şi forma circuitului: 

 schimbarea unităţilor de măsură în sistemul internaţional (dacă în proiectarea pe 

substrat dielectric – alumină – se utilizează câteodată unităţile englezeşti datorită 

înălţimilor standard ale substratelor, în proiectarea circuitelor integrate se lucrează în 

unităţile caracteristice "foundry"-ului utilizat, în cazul acesta SI) 



o 1 mil = 10
-3

 inch = 25.4 μm 

 Modificarea caracteristicilor substratului (Se poate utiliza materialul din biblioteca 

Sonnet standard:  εr = 12.9, tan δ = 6×10
-3

 , ζ ≈ 0) şi a înălţimii acestuia (h = 200μm) 

 Modificarea liniilor microstrip. Caracteristicile care se modifică sunt εeff şi Z0. Pentru 

calcularea noilor valori există relaţii precise de calcul, dar se pot utiliza câteva metode 

mai rapide de proiectare: 

o tabele/grafice de  proiectare (la sfârşitul acestui document). 

o programe de calcul (Exemplu Tools->Line Calc în ADS 2003) 

o pentru acces facil, cu riscurile de rigoare, calculatoare on-line 

 http://www.microwaves101.com/encyclopedia/calmstrip.cfm – calcul 

aproximativ 

 http://mcalc.sourceforge.net/ - calcul după relaţii mai precise 

 În general, regula de bază este modificarea lăţimii traseelor pentru a păstra 

nemodificată impedanţa caracteristică pe noul substrat, urmat de modificarea lungimii pentru 

a păstra lungimea electrică constantă (β·l). 

 Pentru scalarea lungimilor se reamintesc câteva relaţii de bază. Funcţionalitatea 

circuitului nu depinde în general de dimensiuni în mărimi absolute, ci de raportul între 

dimensiune şi lungimea de undă. Pentru a păstra funcţionalitatea la modificări de 

structură/material (cum este cazul în această temă) trebuie păstrat un raport 𝑙/𝜆 constant 

ţinând cont de lungimea de undă diferită, la aceeaşi frecvenţă. Dacă în plus trebuie modificate 

şi frecvenţele de lucru, se introduce o scalare suplimentară. 

𝜆 =
𝜆0
𝑛
=

𝜆0

 𝜀𝑟
=

𝑐0

 𝜀𝑟 ⋅ 𝑓
 

 Pentru circuitul iniţial realizat pe Alumină: 

𝑘𝐴𝑙 =
𝑙𝐴𝑙

𝜆𝐴𝑙
=

𝑙𝐴𝑙

𝑐0
⋅  𝜀𝑟𝐴𝑙 ⋅ 𝑓𝐴𝑙  

 Pentru circuitul realizat pe GaAs: 

𝑘𝐺𝑎𝐴𝑠 =
𝑙𝐺𝑎𝐴𝑠

𝜆𝐺𝑎𝐴𝑠
=

𝑙𝐺𝑎𝐴𝑠

𝑐0
⋅  𝜀𝑟𝐺𝑎𝐴𝑠 ⋅ 𝑓𝐺𝑎𝐴𝑠  

 Păstrarea raportului constant introduce un coeficient de scalare a dimensiunilor: 

𝑘 =
𝑙𝐺𝑎𝐴𝑠

𝑙𝐴𝑙
=

 𝜀𝑟𝐴𝑙 ⋅ 𝑓𝐴𝑙

 𝜀𝑟𝐺𝑎𝐴𝑠 ⋅ 𝑓𝐺𝑎𝐴𝑠

 

 În aceste relaţii εr trebuie privit ca fiind εeff pentru liniile microstrip corespunzătoare, 

dependent de materialul de substrat şi de lăţimea traseelor (ε şi w/h).  



 

Exemplu 

 Să se realizeze un filtru trece bandă, în tehnologie microstrip, cu frecvenţa centrală la 

6.0 GHz, utilizând o structură existentă în literatură (exemplu Sonnet "filtwall.son"). Se va 

utiliza programul Sonnet pentru simulare. 

 

Activitate pregătitoare 

 Înainte de simularea structurii, este esenţială o etapă preliminară de calcul în care 

instrumentele principale vor fi creionul şi hârtia, cu suport teoretic anterior asigurat de 

studiile de geometrie (plană în cazul Sonnet, în spaţiu la utilizarea unui program de simulare 

3D). 

 Pentru prima secţiune de linie din filtrul interdigital: dimensiuni 26×214mil pe 

substrat alumină (εr = 9.8, tan δ = 10
-4

) cu grosimea de 15 mil impedanţa caracteristică a liniei 

este (Line Calc din ADS): 

𝑍0 = 36.58Ω, εeff = 7.025 

 Pentru obţinerea aceleiaşi impedanţe caracteristice pe noul substrat GaAs (εr = 12.9, 

tan δ = 6×10
-3

 , ζ ≈ 0, h = 200μm) lăţimea liniei trebuie să fie 275.75μm condiţie în care se 

obţine εeff = 8.853. 

 În aceste condiţii lungimea secţiunii de linie trebuie să fie: 

𝑙 =
 214 ⋅ 25.4 𝜇𝑚 ⋅  7.025 ⋅ 5.15𝐺𝐻𝑧

 8.853 ⋅ 6𝐺𝐻𝑧
= 4156.06𝜇𝑚 

 Celelalte secţiuni de linie au aceeaşi lungime, dar lăţimile sunt de 22mil (3 linii) şi 

24mil (ultima linie) care devin prin aceeaşi metodă de proiectare 230.23μm 40.27Ω  şi 

252.93μm 38.32Ω . 

 Pentru liniile de intrare/ieşire se obţine o impedanţă caracteristică 𝑍0 = 47.7Ω. Se 

remarcă adaptarea dorită cu porturile de 50Ω. Lăţimea corespunzătoare pe GaAs va fi de 

162μm iar lungimea de 1320μm. 

 Spaţiile dintre "degete" (secţiuni de linie) sunt de 30/38/38/32mil devenind cu 

scalarea în distanţă menţionată anterior 582.62/737.99/737.99/621.47μm. Degetele 2 şi 4 sunt 

deplasate cu 10mil faţă de celelalte, distanţă care devine 194.21μm. 

 În aceste condiţii putem determina dimensiunile volumului de calcul (Box Size în 

Sonnet): 

 X: 4156.06 + 194.21 = 4350.27μm 



 Y: 2 ⋅ 1319.56 + 275.75 + 3 ⋅ 230.23 + 252.93 + 582.62 + 2 ⋅ 737.99 + 621.47 

 = 6538.56μm 

 În acest moment se poate realiza desenarea schemei. E recomandat ca la desenarea 

poligoanelor să se incerce, pe cât posibil, ca fiecare poligon să acopere un număr întreg de 

celule. Acest lucru se poate asigura alegând o anumită discretizare a cutiei, urmând ca fiecare 

dimensiune să fie modificată la cel mai apropiat multiplu al dimensiunei celulei. Estimarea 

unui număr suficient de celule în acest pas este dificilă, dar din nou putem face apel la 

caracteristicile structurii exemplu. Aici întreaga structură cu dimensiunile 390×224mil a fost 

discretizată cu celule 2×2mil (195×112 celule) de unde şi dimensiunile "întregi şi pare" ale 

structurii iniţiale. La alegerea dimensiunii celulelor trebuie să se ţină seama şi de 

caracteristicile tehnologice. În cazul de faţă, considerăm Plessey Foundry F20 utilizat şi la 

curs, caz în care liniile vor fi implementate în stratul de metalizare M3, cu dimensiunea 

minimă implementabilă 10μm şi un control al lăţimii (precizie) de 1μm. In aceste condiţii nu 

se obţin avantaje decisive din utilizarea a prea multe zecimale în determinarea 

caracteristicilor celulei. Vom alege ca dimensiuni iniţiale ale celulei Cx×Cy = 

25.54μm×33.99μm care asigură o diviziune iniţială 256×128 celule apropiată de cea din 

proiect. 

 

Iniţial 

(alumină) 

[mil] 

Calculat 

(GaAs) 

[μm] 

Număr 

celule 

X×Y 

Dimensiuni 

proiect 

[μm] 

Cutie 390×224 6538.56×4350.27 256×128 6538.24×4350.72 

Linii in/out 16/68 162/1320 52×5 169.95/1328.08 

Distanţă Y intrare 34 660.31 -×19 645.81 

Distanţă Y degete 10 194.21 -×6 203.94 

Deget1 26/214 275.75/4156 11×122 280.94/4146.78 

Deget2-4 22/214 230.23/4156 9×122 229.86/4146.78 

Deget5 24/214 252.93/4156 10×122 255.4/4146.78 

Spaţiu1-2 30 582.62 23×- 587.42 

Spatiu2-4 38 737.99 29×- 740.66 

Spaţiu4-5 32 621.47 24×- 612.47 

Suma   257×128 6563.78×4350.72 

 

 Se constată că suma de control a numărului de celule pe distanţa X este 257 datorită 

rotunjirilor ceea ce va implica faptul că una dintre liniile de intrare/ieşire va fi reprezentată pe 

51 de celule lungime în loc de 52. 

 



Desenare structură 

 Se realizează noul proiect completând datele corespunzătoare ale unităţilor 

(Circuit→Units), cutiei (Circuit→Box) şi straturilor de dielectric (Circuit→Dielectric 

Layers).  

    

 Urmează desenarea efectivă a circuitului. În acest pas se vor folosi indicaţiile Sonnet 

în bara de stare (dimensiunile curente ale poligoanelor desenate) şi se va folosi intens 

facilitatea de măsurare pusă la dispoziţie (View→Measuring Tool) pentru a poziţiona corect 

poligoanele. Se recomandă desenarea iniţială a unor dreptunghiuri urmând ca unde este 

nevoie (în acest caz la liniile de intrare/ieşire care se îngustează treptat la atingerea 

primului/ultimului deget) să se adauge puncte care apoi să fie deplasate unde este nevoie. E 

obligatoriu ca opţiunea de fixare în nodurile grilei să fie selectată la nodurile reţelei 

(Tools→Snap Setup) pentru a avea o precizie mai bună de calcul.  

 

 Pe desenul realizat se observă faptul că liniile sunt mai subţiri decât în cazul precedent 

şi de asemenea la distanţe mai mari (datorită în primul rând modificărilor substratului).  



  

 

Simulare 

 Se realizează o primă analiză (recomandat Analysis→Setup→Adaptive Sweep pentru 

o viteză de calcul mai mare) pentru verificarea corectitudinii calculelor geometrice. 

 

 Dacă rezultatul arată îndeplinirea cerinţelor (cum e cazul aici) se poate efectua o 

analiză mai precisă Analysis→Setup→Linear Frequency Sweep care efectuează calculul în 

mai multe puncte.  



 

 Este obligatorie în continuare efectuarea unei analize de convergenţă prin micşorarea 

dimensiunilor celulelor, cu scopul de a observa dacă analiza realizată este destul de fină. Se 

realizează relativ uşor o înjumătăţire a celulelor pe ambele dimensiuni (mărire de 4 ori a 

numărului de celule) în secţiunea Circuit→Box selectând Lock în secţiunea Box Size şi 

mărind (dublare sau eventual mai mult dacă este nevoie) numărul de celule. În cazul acestui 

circuit, calculul cu  512×256 celule nu aduce un spor de precizie lucru care se poate observa 

prin suprapunerea celor două grafice (ţinând cont că estimarea iniţială a fost "împrumutată" e 

normal să fie suficient de bună). 

 

 În sfârşit se prezintă posibilitatea de a afecta (în anumite limite!!!) funcţionarea 

filtrului prin modificarea lăţimii degetelor şi a distanţelor dintre ele pentru a afecta cuplajul. 

Se prezintă situaţia obţinută pentru linii mai late, cu efectul măririi benzii de trecere după 

cum se observă la comparaţia cu cazul anterior. Totuşi, mărirea laţimii liniilor ar trebui 

însoţită de o mărire corespunzătoare a cutiei, pentru a păstra frecvenţa centrală dorită. 



 

 

Activitate independentă 

 Să se realizeze un filtru trece bandă, în tehnologie microstrip, cu frecvenţa centrală la 

o altă frecvenţă decât cele speecificate (de exemplu 7.0 GHz). 

 

Supliment teoretic (opţional) 

 

Relaţii de calcul pentru linii 

1. Linia microstrip 

 Varianta cea mai importantă şi cea mai utilizată dintre liniile de transmisie este linia 

microstrip. 

 

t 

h 

w 

r 

 

Linia microstrip 

 Linia este realizată dintr-un conductor panglică îngust cu lăţimea w şi grosimea t 

(standardizată) plasat pe partea frontală a stratului dielectric şi un al doilea conductor 

acoperind întreaga suprafaţă a substratului, de grosime variabilă în funcţie de necesitate şi 

conectat la masă. 



 Spre deosebire de configuraţia strip-line unde conductorul se găseşte între două plane 

de masă (figura 1.a), în liniile de transmisie microstrip nu se propagă numai modul TEM, 

acestea tinzând să fie dispersive, în sensul că linia are constantă de dispersie şi impedanţă 

caracteristică variabilă cu frecvenţa. Ca urmare undele care se transmit pe linie vor fi moduri 

quasi-TEM. Efectul este mai pronunţat când frecvenţa este în apropierea frecvenţei de tăiere a 

modului TEM. 

 Vom determina în continuare expresia impedanţei caracteristice a liniei microstrip, în 

conformitate cu relaţiile descoperite de Kirschning şi Jansen (Electronics Letters, 18 martie 

1982, vol. 18, No. 6, pp 272-273), validate experimental de Deybele şi Bayer (IEEE Trans 

MTT, vol. MTT-35, No. 5, mai 1987, pp 535-538). 

 Relaţiile sunt rezultate în urma simulărilor pe calculator şi ca urmare au un puternic 

caracter empiric. 

 Cu notaţiile: 
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 vom obţine lăţimea corectată pentru mediu omogen: 
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 Efectuăm corecţia pentru mediu neomogen: 
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 Se utilizează Ur şi r pentru determinarea unei valori Y intermediare: 
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 Se găseşte impedanţa caracteristică fără efectul frecvenţei (la frecvenţe joase):  
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 funcţia  xZ01  fiind dată de: 
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 Determinăm constanta dielectrică efectivă la joasă frecvenţă: 
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 Aceste relaţii se datorează în principal lui Hammerstad şi Jensen (“Accurate models 

for microstrip computer-aided design”, 1980 IEEE MTT-S International Symposium Dygest, 

May 1980, IEEE Catalog #80CH1545-3MTT, pp. 407-409). În continuare se prezintă factorul 

de umplere P introdus de Kirschning şi Jansen, care oferă precizie mai bună în ceea ce 

priveşte dispersia în frecvenţă. 
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 Aplicând această relaţie vom găsi permitivitatea efectivă şi impedanţa caracteristică la 

o anumită frecvenţă f. 
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 În aceste relaţii avem următoarele exprimări numerice: 

       ns/mm792.299c,73.376,GHzf,mmh 0    (13) 

2. Linia strip 

 Vom calcula impedanţa caracteristică a unui linii strip (figura 3.) 
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Linia strip-line 

 Relaţii unitare şi precise de calcul pentru calcularea impedanţei caracteristice a liniei 

de transmisie strip dacă sunt îndeplinite următoarele condiţii: 

 Conductorul interior este centrat între cele două plane de masă. 

 mediul dielectric este omogen şi izotropic în ceea ce priveşte constanta dielectrică. 

 Liniile strip lipite cu  adezivi pentru îndepărtarea aerului de la marginile 

conductorului central pot fi proiectate cu precizie cu aceste relaţii. În cazul liniilor realizate 

prin presare impedanţa şi constanta dielectrică vor fi puţin mai mici decât cele calculate 

datorită spaţiilor existente la interfaţa dintre cele două plăci. 

 Analiza liniei strip a fost făcută de S.B. Cohn (“Characteristic Impedance of the 

Shielded-Strip Transmission Line”, IRE Trans MTT, iulie 1954, pp 52-57 şi “Problems in 

Strip Transmission Lines”, IRE Trans MTT, martie 1955). Astfel pentru cazul liniilor 

înguste: 
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se poate realiza calculul bazându-ne pe conductorul circular echivalent. 
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 Acurateţea acestor relaţii lasă de dorit când X>0.11, caz ce trebuie evitat în practică. 

 Cazul liniilor late: 
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se bazează pe capacitatea de dispersie: 
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 Relaţiile (17),(21) determină un punct de discontinuitate în jurul punctului caracterizat 

de egalitate în (14),(18). Se poate realiza o medie aritmetică a rezultatelor obţinute cu cele 

două relaţii pentru variaţia raportului (14),(18) între 0.3 şi 0.4 (de exemplu). 

 

3. Materiale uzuale utilizate în realizarea substraturilor 

 Materialul dielectric este placat pe ambele feţe cu cupru, prin metoda electrodepunerii 

sau prin presare mecanică. Grosimile stratului de cupru sunt standardizate şi sunt indicate 

prin raportul greutate / suprafaţă în uncii / picioare pătrate (oz/ft
2
) cu 1oz=28.35g şi 

1ft=30.48cm. Grosimile standard şi exprimarea în oz/ft
2
 sunt indicate în tabelul 1. 



Greutatea cuprului depus Grosimea stratului 

oz/ft
2
 g/m

2
 inch mm 

0.5 152.58 0.0007 0.0178 

1.0 305.16 0.0014 0.0356 

2.0 610.31 0.0028 0.0712 

 

Tabelul 1. Grosimi standard ale stratului de cupru 

 

 În sistemul internaţional grosimea stratului de cupru se exprimă prin mărimile 

standard de 17m, 35m şi 70m. De obicei grosimea stratului de cupru utilizată va varia 

crescător cu creşterea puterii controlate de circuit şi descrescător cu creşterea performanţelor 

circuitului (factor de calitate). 

 Şi grosimile stratului de dielectric sunt fixate, fără a fi însă standardizate. Fiecare 

firmă producătoare oferă anumite valori ale grosimii dielectricului cum ar fi: 0.38mm, 

0.44mm, 0.50mm, 0.79mm, 1.57mm, 3.18mm în cazul firmei Rogers Corporation. 

 Materialele pentru substraturile dielectrice ale circuitelor integrate pentru microunde 

se împart în două mari categorii: 

1. Materiale plastice (organice) 

2. Materiale anorganice 

 Dintre materialele plastice putem aminti politetrafluoretilen-ul (PTFE sau TEFLON). 

Acest material a fost mult timp unul dintre cele mai utilizate materiale deoarece, întărit cu 

fibră de sticlă, materiale ceramice sau chiar cristale mici de sticlă orientate aleator oferă 

caracteristici foarte bune de stabilitate electrică, termică şi mecanică. Dezavantajul major al 

utilizării acestui substrat o reprezintă costul crescut de prelucrare, datorită necesităţii 

corodării cu sodiu sau plasmă şi a lipirii cu adezivi activi la temperatură ridicată. 

 O alternativă ieftină, dezvoltată la apariţia bunurilor de larg consum ce funcţionează 

în gama microundelor, este materialul denumit FR4, realizat dintr-o combinaţie de răşină 

epoxidică şi sticlă. Performanţele mecanice ale acestui material sunt foarte bune, de asemenea 

tehnologia de prelucrare este simplă, însă proprietăţile electrice sunt mai puţin bune ceea ce a 

dus la utilizarea acestui substrat mai ales în aparatura de preţ redus, fără calităţi deosebite. 

 Materialele anorganice care sunt utilizate ca substraturi sunt materialele ceramice (de 

obicei alumina Al2O3), materialele monocristaline (safir, cuarţ), semiconductori, substraturi 

feromagnetice. Acestea din urmă sunt utilizate în general pentru realizarea dispozitivelor 

nereciproce: circulatori, izolatori şi schimbători de fază (ferite). 



 Materialele semiconductoare au de obicei pierderi prin conducţie destul de mari din 

această cauză se preferă utilizarea lor numai la realizarea circuitelor integrate monolitice 

pentru microunde, care se bucură de avantajul realizării pe acelaşi substrat şi a componentelor 

active şi a celor pasive. 

 Materialele anorganice cristaline au dezavantajul preţului crescut al materialului 

intrinsec (safir) sau al unor pierderi dielectrice mari (sticla). În plus, materialele cristaline 

sunt predispuse la prezenţa anizotropiei dielectrice, ceea ce ridică dificultăţi suplimentare în 

exploatare în sensul identificării axelor optice principale a cristalelor. 

 Alumina este un material ceramic care are proprietăţi excelente din toate punctele de 

vedere. Ea se poate produce în două variante, cu puritate de 99.5% şi puritate 96%. Desigur 

că materialul cu puritatea mai mare este mai performant însă este şi mai greu de obţinut. 

Tangenta unghiului de pierderi pentru alumină are o valoare foarte mică, de asemenea 

coeficienţii termici de expansiune liniară, iar conductivitatea termică este foarte mare. 

Dezavantajul major al acestui material este însă costul de utilizare foarte mare (de 

aproximativ 10 ori mai mare decât pentru PTFE: 35$/in
2
 faţă de 2.8$/in

2
). Acest lucru impune 

utilizarea aluminei mai ales în aplicaţiile de performanţă foarte ridicată, cum ar fi tehnologia 

spaţială. 

 Se prezintă în tabelul 2 caracteristicile principalelor materiale utilizate: 

 Constanta 

dielectrică 

relativă 

Factorul de 

pierderi 

dielectrice 

Conductivi-

tate termică 

Coeficient 

liniar de 

expansiune 

Coeficient de 

temperatură 

al lui r 

Material - - W/cm/K ppm/K ppm/K 

Al2O3 (99.5%) 9.8 0.0001 0.37 6.3 +136 

Al2O3 (96%) 9.4 0.001 0.35 6.4 - 

Safir 9.4;11.6 0.0001 0.42 6.0 +110 ÷ +140 

Sticlă quarţ 3.78 0.0001 0.017 0.55 +13 

Sticlă Corning 

7059 

5.75 0.0036 0.012 4.6 - 

BeO Ceramic 

(98%) 

6.3 0.006 2.1 6.1 +107 

TiO2 85 0.004 0.05 7.5 -575 

Tetratitanat de 

Ba (BaTi4O9) 

37 0.0005 0.02 9.4 -26 

Zirconat 20-40 0.002 - 5.0 -130 ÷ +100 

GaAs 12.9 0.002 0.46 5.7 - 

Si 11.9 0.015 1.45 4.2 - 



 Constanta 

dielectrică 

relativă 

Factorul de 

pierderi 

dielectrice 

Conductivi-

tate termică 

Coeficient 

liniar de 

expansiune 

Coeficient de 

temperatură 

al lui r 

Material - - W/cm/K ppm/K ppm/K 

Ferită 9-16 0.001 - - - 

 

Tabelul 2. Proprităţile principalelor materiale utilizate ca substraturi 

 

 În ultimul timp se remarcă apariţia unor materiale noi obţinute prin combinaţiile 

materialelor prezentate anterior care să îndeplinească simultan două condiţii: proprietăţi la fel 

de bune ca ale PTFE, alumină, la un preţ de cost asemănător materialelor ieftine: FR4. 

 De exemplu firma Rogers Corporation oferă materialele din seriile RO3000 

(combinaţie PTFE şi material ceramic) şi RO4000 (combinaţie hidrocarbon-ceramică întărită 

cu sticlă) care oferă la preţuri mici calităţi deosebite electrice, termice şi mecanice, împreună 

cu avantajul unei tehnologii asemănătoare cu a răşinii epoxidice (FR4). 


